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Corkscrew Collector Version 9.0 Users' Guide 
Last updated August 1, 2012 

 
I. Introduction 
 
This program is a companion to SCReWBase which is the Catalogue that is used as a 
reference for corkscrew collectors World-wide. 
 
SCReWbase was designed by Fred Kincaid, Frank Ellis, Fred O'Leary and Joe Paradi to address 
the needs of corkscrew collectors for a comprehensive and knowledgeable corkscrew 
catalogue.  The first software was built by Ms. Kathleen Cinelli and all versions of Corkscrew 
Collector 3.6 and earlier was her work.  The new version first released in 2008 obsoletes 
everything as the software is a complete rebuild.  However, the connection between 
SCReWBase and Collector is much stronger in this version and, in fact; Corkscrew Collector 
is only available with SCReWBase because of the deep integration designed into it. 
 
The first release of Corkscrew Collector (CC6) was designed with the same technological 
ideas as SCReWBase and is quite similar to it, but really it is much more complex.  The new 
program encompasses the ideas since we abandoned the old program and excludes the 
problems of the old – this release of the software was designed and built by Joseph A. Paradi 
(Joe Paradi's son). 
 
Moreover, for those who had already used CC3.6 or earlier versions, a data conversion 
program is provided – for a ONCE ONLY USE because once you convert and add new records, 
there is no going back!  If you ignore this advice, you may wipe out all your work, so if you 
are unsure of anything, just contact us!  Please heed this advice and always back up your 
work before you try something new! 
 
The latest release is "CC9" dated August 2012 and has a number of improvements over CC8 
– this Users' Guide reflects CC9.  There are additional features, many improvements in the 
way users enter data and we tries hard to make everything clear and user friendly. 
 
II. Organisation 
 
The SCReWCode is built from 3 alphabetic and 3 numeric characters (e.g. ABc123).  But, in 
CC the user can use any coding system s/he wishes to, however, the best strategy is to use 
an augmented SCReWCode (the equivalent SCReWCode plus a lower case letter).  A collector 
may have more than one copy of a corkscrew so, that must also be allowed for, as well as 
the instances when the corkscrew in question does not yet (or maybe never will) exist in 
SCReWBase. 
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So let us first see how this works for those who adopt the SCReWBase coding system for 
identification of their own corkscrews.  The first capital letter is the Class designator, the 
second capital letter stands for the Type of a corkscrew under the Class and the third letter 
is lower case and is the style which is specific to the Class/Type under which it is.  Finally, 
the 3 numeric digits are just serial numbers for the C/T/s codes – just see the SCReWBase 
Users' Guide for more explanation.  
 
Therefore, a user who adopts the SCReWCode for CC will have the same Code as in 
SCReWBase plus a lower case letter of the alphabet (a, b, c,….z) after the 6 digit code – 
Abc123a for the first copy and ABc123b for the second and so on.  CC was built to make life 
really easy for this plan as it will ask for the code and assign the small letters after the code 
automatically.  This means that you never have to keep track of how many you have or what 
the last letter was.  CC will fill in the fields and include the SCReWCode in SCReWBase in the 
field for it for you, plus the entry date as well.  Now you are ready to fill in the fields as you 
want them. 
 
Another important feature is the Public/Private mode.  If you are running the software and 
someone is with you who is watching what you are doing, you may not want to show them 
your private information, such as how much you paid for it, who you bought it from etc.  But 
when you are alone working with the system, the Private view is what you will use where all 
information is available.  We will show you how this works later in this document. 
 
For those users who decide to use their own coding system as many had before these 
programs were first developed, there is the issue of converting the old codes to new ones, if 
you decide to do it. This is not as big a job as you think but if you do want to do this, 
contact us first.  If you stay with your coding system, the CC software allows this as an 
option and then all works as normal, except you have to enter the equivalent SCReWCode 
manually and the program won't keep track of the number of the copies you may have (in 
other words, it won't assign the lower case letters a,b,c,…z). 
 
If you have a corkscrew that is not in SCReWBase, there is still an opportunity to enter a 
record.  SCReWBase was designed to take this into consideration as there are no "900" 
numbers in SCReWBase – that is no SCReWCode such ABc910 can exist.  All 900 and above 
numbers are reserved for corkscrews in CC that do not have SCReWBase entries.  So records 
are created by the user just establishing the C/T/s letters and CC assigns the 900 number in 
sequence.  For example, you have a Figural (squirrel) Wild animal and it is a "T" pull – this 
gives you a code of FWt and the software will then build the code FWt900a for you as this is 
the first such piece not in SCReWBase.  But, if you had already a piece that was not in 
SCReWBase but was the same FWt code, then the software would create the code FWt901a or 
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if you had a second copy of the same squirrel already, you would enter FWt900 and the 
software would create the code FWt900b – it is this easy and convenient! 
 
In a future release there will be a function to submit all 900 coded records to SCReWBase for 
potential inclusion into SCReWBase.  For those who use their own coding system, this will 
not work either and they would have to submit new finds via e-mail. 
 
This complete redesign and rebuild of the Corkscrew Collector program is much more user 
friendly and extremely easy to use.  The following pages will explain what each of the 
functions (the purpose) are and how to use them.  Many functions and operations are 
identical to SCReWBase but these will be repeated here.  Naturally, the two programs were 
very deliberately designed to have the same look-and-feel and the way they operate so the 
user does not have to learn a whole new protocol for each. 
 
III. Page layout – what is available 
Here is what a typical page looks like when it is in the Public mode: 
 

 
We will take the page section by section as follows: 



 4

 
1. Menu line: 

The File tab allows: 
Backup Database – to make a backup of the database; it is 
recommended that you do this after each use or at least on a regular 
basis. 
Restore Database – allows you to revert to a saved (backed up) data 
file, in case of a real problem you encountered that had 
compromised you data (disk crash, etc.).  This is also a neat feature 
when you have two or more computer and you want them all kept up 

to date (see further explanation below) 
Print Public – allows you to print a one page report of the record showing only details that 
do not include private data. 
Print Private – as above, but it does include all private data as well. 
Exit – allows you to close the program. 
The Restore Database when used as the feature to copy a database from one computer to 
another is used as follows: 
1. On the "source" computer from which you are copying the database do a backup (the 
command is under the File button – see above) and save the backup file on the source 
computer's desktop. 
2. Then, copy this backup file with a name something like this: 
collector_backup_2011_55_31.sdf onto a memory stick in the "source" computer. 
3. And then copy this file onto the desktop on the "target" computer to which you are 
transferring the data. 
3. Now open the CC software on the "target" computer and you will see under the File button 
a "Restore" function.  Click on that and follow instructions.  Now you will have all your data 
there. 
Note: We assume that you had already installed the same version of both the latest SB and 
CC programs on the "target" computer before you do the above transfer. 

The Reports tab allows: 
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All reports start out similar to this.  The notable issues are that on some, you have the 
option to choose: 
1. Which Classes you want to report on (ALL) is the default 
2. The "Purchase Date" check box defaults to the "All" option, but if you click this off, you 
can choose the date range you want to see. 
3. The Date range for the report is set here, if you choose it – From/To dates 
4. You can also choose what you want to report on, the options are: "Collection", "Not in 
Collection" and "Sold or Traded". 
 
Now, just click on the button and the report will be generated. 
 
Collection Detail – will print a complete report with a selection of data items for every 
corkscrew in the database – here is an example: 

 
 
Collection Cost/Value – very similar to the first report but has some different data and 
shows the differences between cost and present estimated values. 
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Insurance Report – is a report listing corkscrews over a set value (you specify the minimum 
value) – here it is $100. 

 

 
 
Class Summary – is a one page report which summarizes all SCReWBase classes in one neat 
little report (the full values have been partially erased to preserve the privacy of the report 
owner, so the numbers do not add up). 

 
Sold and Traded Report – Be sure to select the "Sold or Traded" status at the top in addition 
to other parameters above, otherwise you will get your entire database reported.  

 
Now the report appears as follows: 
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Note that certain fields and values have been erased to maintain the privacy of the 
participants. 
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Sold and Traded List  finds the greatest use when you need to account for past 
activities as in valuations and even for tax purposes. 
 

 
Here is what you get: 

 
Note that certain fields and values have been erased to maintain the privacy of the 
participants. 
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Tablet Report  is an incredibly useful report.  This creates a PDF file of your 
collection which is formatted to fit tablets (iPad, Samsung, Blacberry, Android, 
windows and others).   

 
You have some choices here.  In the class box you can select one Class or ALL (which 
is the default).  There is a Min Value box on the right and here you can put a lower 
limit on what will be in the report (you may not want the cheap stuff to be there).  
The, just click the Run button and away you go. 
 
You will love it!!!  Here is what one page looks like: 

 
But be careful if you ask for the entire database, the report generation will take a 
considerable amount of time, perhaps even a half hour and the resulting file will be 
very big! 
 
The Tools tab allows: 
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Options – where you can specify if you want a 
full page display when the page opens and 
you can specify a new default report start date.  
The last option (circled) here is for those users 
who have their own private coding system.  By 
clicking the box, a check mark appears and 
the software will skip all the logic in defining 
codes, 900 numbers and adding a,b,c,…z 
letter at the end of the code.  Be careful; click 

this ONLY if you intend to use your coding system, other than SCReWCode.  Although you 
can switch back to the SCReWCode system, the records you had entered with your own code 
will remain like that.  This is a very good idea if you have your own system at the start but 
you want to convert to the SCReWCode standard later.  Just enter new pieces with the 
SCReWCode system and later on change the old codes to the SCReWCodes as time permits. 
 
The Help tab has: 

 
 
Screw Companion will bring up the document in a PDF document. 
User Guide will bring up this document in a PDF file format and you can read it or print it as 
you wish. 
 
Go to the website will take you to the Corkscrew Software Website at: 
http://www.corkscrewsoftware.com/ 
Where you will find the latest software news and you can ask questions. 
 
About displays the version of the software you are running here. 
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It is very important that if you have any problems that you report it with this version number 
so the problem can be traced to its roots.                 
 
2. Command Line: 

 

 
  A    B     C                 D  E     F           G            H  I  J          K 
The fields are marked with letters and here is the same set in SCReWBase but CC has 
additional functions as you will see below and here is what these will do: 
A – This button |< allows you to skip to the very first record in the database – "C" below 
goes to the very last record. 
B – The field that allows you to advance or reverse the records you want to see, also they 
show how many records are in the database – 4475 in this case. 
C – This button >| allows you to skip to the last record in the database – "A" above goes to 
the very first Class. 
D – The "binocular" or position button moves the record pointer (highlighted record) to 
wherever you want in the database – the start of the LD Class/Type here.  But there is 
another way to get this done too – just enter a class Letter or a code completely and then 
while holding the shift key, press the Enter key – works like a charm! 
E – is the search toggle button (like a magnifying glass).  You can either search the database 
or use the filters explained below.  When you are in search mode, this button is green (as 
shown).  When you are in filter mode, this button has a blue background and the filter 
button (G) is green (looks like a funnel).  To return to search mode you click on this button. 
F – The search field – type in what you are looking for – e.g. Perille and then hit Enter to 
search.  The record will be found in which the word or characters exist that are displayed in 
the F box.  Hint: search for more than one character as a single letter is in every record in 
the database.  Note:  This is a different function than the Binocular or the Shift-Enter 
combination – those positions the data base while this one actually Searches it and lists only 
the records that meet the search criteria.  Try it and see how useful this is. 
G – Filter toggle button (a funnel) that is similar to the search toggle button.  If it is green 
then you are in filter mode and if not, you can click it to switch to filter mode. The filter 
mode enables the filtering by Class/Type/Style – e.g. select all Z Class only.  Hint: using this, 
you can get a count of the records in the database for a class 
H – The Class selector box 
I – The Type selector box 
J – The Style selector box 

K – If this button shows  only the current collection is shown no "Sold or Traded" or 

"Not in Collection" are included.  If  shows, everything is displayed.  This also 
works for searches and all other functions. 
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Here are the special buttons for CC – the difference between SCReWBase and CC. 
 

 
            W  X   Y   Z 
W – "save" the current record you are editing – if you forget, the system will ask you to do it 
anyway as soon as you try to move to a different record or close the system (see picture 
below). 

 
This is what happens if you had changed the record but did not "save" it using the diskette 
icon: 
 

 
 
X – this button allows you to add a new record.  When clicked on you get: 
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Here, you have some choices.  If you are using the SCReWBase coding system, enter either: 
1) the actual SCReWCode that you determined before (most likely you already found it in 
SCReWBase; or 2) enter the 3 digits for Class, Type and style C/T/s and the system will 
assign a 900 number, plus a small letter (a,b,c,…z) as appropriate; or 3) enter your own 
code if you are using such.  When you click on Enter, CC will create a record and you can 
start filling it in.  Hint for users who use their own coding system – it will be very beneficial 
if you enter the appropriate SCReWCode when the new record is displayed for editing as 
shown below (with the red circle around it) along with the Class/Type/Letters (green circles) 
because this will allow you to use most of the features of this program. 
 

 
 
Y – this button allows you to delete a record. 
 

 
 
Z – this button opens up the private data areas below the left list column as follows: 
 

 
 
The additional fields are shown here in the box on the left.  All of these are user filled and 
the Tex1 – 3, Currency1, Date1 and the Numeric1 and 2 are user defined and are used for 
whatever you see fit.  Note also the additional two tabs next to the "References" tab.  These 
are for users who collect Auction History data or want to add a long memo in tab Memo1, 
more about these below. 
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Hint for users who use their own coding system – although you decided to use your own 
coding method, you can still make use of almost all of the features of this system.  For 
example, the filter function works if you entered the Class, Type and Style identifiers into 
the appropriate boxes when the record was entered (or at any time later too) – see the notes 
above.  The filter function works on the system letters Class/Type/style as shown here (this 
is one reason why these letters should be filled in when the record is entered or even later): 
 

 
Therefore, you can look at the list of corkscrews you have in any Class and even to the most 
detailed C/T/s defined list even if your coding system is unique and unrelated to SCReWBase. 
 
3. Record List Column 
This part of the front page shows the list of records at this part of the database – that is 
wherever you positioned it before.  The following information is available: 
Code – shows the SCReWCode of the record. 
Description – is a brief one liner of what the record is. 
Hint: you can see the whole description if you move the horizontal slider at the bottom or 
highlight the record and then read all the information in the record in the next box. 
Hint: you can scroll down using the slider on the side, or better yet, the down arrow to get 
to the next line. 
 

 
 
4. Collector data 
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This is self evident, the SCReWCode (if you know it), Class letter and name, Type letter and 
name, and Style letter and name.  But the "Collection" field has three obvious options: 
 

 
 
Normally, the "Collection" option is used and it is the default, so you don't have to do 
anything if you do own the corkscrew.  However, if you have it on you "wish list" or needed 
list, then use the "Not in Collection" option.  Finally, if you "Sold or Traded" a corkscrew and 
so it gone from the collection, but you want tyo keep the record, use this option. 
 
Then, note the box in front of the "ShowSB" title.   If you click this, a check mark will show 

and the page will display the SCReWBase data if there is a SB record 
with the same SCReWCode that you have entered on this record – note 

that the page with SCReWBase information will have slight yellow tint to show that this is not 
your data.  The left picture below is not checked (all white background), the right one is 
checked (some yellow background) – note the different pictures and different descriptions 
and data.  Note: the check mark stays on so you can go from record to record if you want to 
see SCReWBase records but you have to turn it off when you no longer want it – it will not go 
off on its own! 
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Look at the graphics above the top picture is the "normal" state and the bottom when you 
had clicked the "ShowSB" button. Now you will see a small button "Copy" to the right of the 
ShowSB checkbox (circled in red) which allows you to copy SCReWBase data into CC records.  
This is a great way to save effort by taking much of the information easily from the 
SCReWBase database.  When the Copy button is clicked, a dialogue box Copy Fields from 
SCReWBase pops up as seen below: 

 
 
 
Now you can copy using any of the fields given by 
clicking on the check-box and when you click OK the 
data will be copied into your record.  But, the data 
copied will NOT destroy anything you have already in 
the fields checked but will just add to it by 
concatenating it to what you might have, if anything.  
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5. Comments 

 
Simply, details as they are available – sometimes a lot and sometimes little, but you are in 
charge here, enter as much as you like! 
 
6. Details 
More details about the piece.  Again, this is all 
your private information, but much could be just 
copied from SCReWBase as shown above. 

All fields are self-evident, except the "Location" 
one which is used to show where the piece is in 
the collector's house, vault, storage, drawers, etc. 

Note that five of the fields have drop down 
buttons which allows you to pick from a number 
of standard options built in.  For example, 
Country of origin (United States here) will give 
you many choices (the typical corkscrew maker 
Country) – but if your Country of Origin is not 
there, you can just type it in. 

 
7. The picture 
 

The picture is normally yours, but you could 
copy it from SCReWBase or wherever (if you 
just have it as a piece you covet and shown as 
"Not in Collection").  But if you have the piece 
then typically, you would use your own picture 
because every corkscrew is unique as it has 
been used and scratches, wear, damage, etc. 
make it unique so it can be identified 
specifically (good for insurance purposes).  
Hint: - if you left-click on the picture, you will 
get a usually larger picture with details more 
clearly shown – this is limited by the details 
supplied by the photographer who took the 

picture.  Here both sides are photographed and then a single picture is formed by joining 
the two together. 
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Here is how to ADD a Picture to the record.  You will find at the lower right part of the 
screen the following 3 boxes: 

  
Click on the "Add Image" button and the system will open a typical Microsoft file box: 
 

 
 
All you have to do is to navigate to the place where the picture is stored, select the picture 
file you want in this record, click "Open" and it is done. 
 
8. Reference Material 
 

 
 
Here we have references to publications on corkscrews, complete with the book or 
document title, author, publisher, the page number(s) and the year of publication.  Note also 
the other two tabs which may be used for private information as shown here. 
 
Here is how to ADD a Reference to the record.  Move the cursor into the Reference field and 
Right-Click the mouse.  The following box comes up: 
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Now click on the "Add a Reference" and a small box pops up on the screen: 
 

 
 
There is a long list of corkscrew reference books and other publications already in the 
system and by clicking on the pull down list button (circled in red above), the alphabetically 
sorted by Author list drops down and you can select the publication you want in here:  
 

 
 
Click on the one you want and then enter the page number where the piece is in the 
reference document. 
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But if you do not find the reference you would like to insert here, just click on the <NEW> 
entry and the software gives you the following options: 
 

 
 
You can now type in your own reference details as shown here and enter the page number in 
the reference where the item is that you selected.  When done, click OK. 
 
Auction History is a place where you may wish to record auction data from wherever you 
follow corkscrew trading (e-Bay, Christie's, etc.)  This information will provide you some 
basis for evaluating your Estimated Values (Est. Value) in the private area. 
 

 
 
How to ADD, DELETE or EDIT an Auction History item is shown here.  First, click on the 
Auction Item tab.  Then right click in the space a box pops up showing three options: 
 

 
 
If you click on the Add an Auction Item, the following box pops up and you fill in the data as 
you have it.  Click "save" and it is done: 
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To Edit this Auction Item, you follow the same instructions as above for entry, except select 
the one item you want to edit, Right-Click in the space and select the Edit option.  The same 
box as above comes up with the information filled in and you can edit it as you like. 
 
To Delete this Auction Item, move the cursor into the space.  Now select the item you want 
to delete and then Right-Click to bring up the dialog box, select Delete this Auction Item 
and the system will show the following caution box and you do what is appropriate: 
 

 
 
Private Memo Field is under the tab Memo1.  This field is similar to the Auction History, but 
free format that can be used as desired.  Note that this only shows in Private mode – in 
public mode it is hidden as are the other private fields.  Just click on the tab and then click 
in the field and start typing or editing or deleting, whatever you want. 
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IV. Finding things 
This is essentially the same process as in SCReWBase except that you would know that you 
entered the corkscrew into CC already.  Of course, from time-to-time, most of us forget 
what the exact SCReWCode is for a specific item, so finding it will be important when we 
want to see something about it.  So here is one way to get this done. 
 
If you know the Class or even the Type of a corkscrew you want to identify, just type the two 
letters and then click the binocular (or type Shift-Enter) and the pointer (highlight in the 
Record List Column) will be placed at the start of that Class/Type.  If you entered the entire 
6 digit code (no need for the "a", "b", etc.) then the record will be found.  Note that this 
function only looks at the Code while the Search function searches all useful fields. 
 
You can enter a name such as "Perille" or a word such as "France" or "Syroco" (no quote 
marks are required) and the items which contain the character string you typed in will 
appear in the Record List Column: 
 
Here we searched for the word "Perille" and found 70 records that contained the word. 
 
Hint: - it is best to select search criteria as close to what you want as possible so that you 
don't have too many to look at. 
 
Once the search is complete you can just scroll down the list until you see what you want. 
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V. Conclusions 
Thanks to all users of this software who had made suggestions and helped to find bugs and 
shortcomings as without them this work would not have born fruit.  Also, our software 
designer Joseph A. Paradi had done a great job, so we have a terrific program and this 
enables corkscrew collectors to record their corkscrews in this system. 
 
We had also included some Frequently Asked Questions and answers in the Appendix. 
 
To buy, go to:  http://www.corkscrewsoftware.com/ and follow instructions.  
 
Joe Paradi. 
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Appendix 
 
Frequently Asked Questions 
 
1. What if I entered a wrong SCReWBase code and then clicked the ShowSB box? 
You will get a clear yellow set of fields because the SCReWBase record does not exist, so 
there is nothing there!  Or, if there is a record by that Code but is not the one you want, it 
will appear – and you will immediately see the problem. 
 
2. I had submitted a "900" record and the record now appears in SCReWBase.  I want to 
change my Code to that of the SCReWBase one.  How do I do that? – You type in the new 
SCReWBase base code in the Code box and that is it.  However, you will likely have a picture 
already named the same 900 Code.  The system will automatically change the picture's 
name to match the new code you typed in.  When you try to move off the field, you get the 
following message: 
 

 
Click on whichever button is correct. 
 
3. What if I want to change the Code for a record? – type in the new code number in the 
Code box and see FAQ #2 above. 
 
4. I had copied the picture from SCReWBase when I bought the piece but now I have my own 
picture.  How do I replace the picture? – Just below the picture you will find the following 

boxes: .  Click on "Delete Image" and the 
system will delete the address in the third box here and also ask you if you want to delete 
the picture permanently: 
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Answer Yes or No. 
 
5. Can I email a CC record to a friend? – Yes.  From the pull down menu "File" choose Public 
or Private Print.  When the report appears, there is a small copy icon (blue diskette picture) 
and this gives you two choices: 
 

 
 
Choose whatever software you have so that the image is written to your hard disk (e.g. 
Acrobat (PDF) file) and when asked where to save it, name the file then save it to where you 
can find it later.  Then, simply "Attach" this page to an ordinary e-mail to your friend. 
 
6. How do I know which codes in my Corkscrew Collector have changed? – With each new 
release of SCReWBase a report and references from old and new for all changes will be 
available in the release download or on the distribution CD. 
 
7. I took a better picture of my corkscrew, how do I replace the old one? – See FAQ #4 above 
– the same action is required. 
 
8. All of a sudden all my data is gone and the screen is yellowish, what happened? 
You left the check mark on in the ShowSB box – click it off and all will be back to normal. 
 
9. Will I receive a new disk each time a new version of the software released?  - Yes as there 
are too many system changes necessary due to Microsoft and other technology changes. 
 
10. How much will it cost to get new releases? – There will be an annual fee for new releases.  
Go to the website: http://www.corkscrewsotware.com/ and see what the current prices are.   
 



 26

11. How often will new versions of the software be available? – The plan is to have new 
versions available annually. 
 
12. How do I position my record column to a specific record? – Just type the record Code in 
the search box at the top and either click on the Binocular or type Shift-Return.  You can 
also Search for it and get the one record only. 
 
13. How do I get back to the full listing after a Search? – Click on the green magnifying glass 
(E) or the Red [X] just after the search box.  
 

 
 
14. How do I cancel the Filter function and return to the full listing? – Same answer as FAQ 
#13.  But other methods also work – type in the Search box where you want to go next (even 
one letter representing the Class is enough) and click on the Binocular or type a Shift-Return. 
 
15. How do I customize my reports? – There are several options built into the reporting 
functions – here is one example: 

 
 
a. You can select a specific Class only 
b. You can set a range of dates for which you want the report 
c. You can print only Collection, Not in Collection or Sold or Traded reports 
d. You shou8ld click on the "All" check box to make sure you get everything if you want. 

Hint: you can combine all of the above for any report.  Other reports have similar options. 
 
16. I use my own coding system but want to also use the SCReWBase data for reference, how 
can I do this? – There are several issues here and all have been discussed in the Users' Guide.  
Please see the sections printed in blue as these refer to the issues you are concerned with. 
 
17. If I just want to buy CC alone, without SCReWBase, how much will it cost? – Because of 
the deep integration between CC and SB, it is not possible to purchase or install just CC.  
You must buy the bundle of SB and CC and install both applications completely.  You do not 
have to use the integration with SB if you do not want to, but it must remain installed on 
your computer for CC to function. 
 
18. But what do I do if I have my own spreadsheet based records?  There is a Data 
conversion utility you can get from the website by e-mailing. 
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19. How do I submit corkscrew records for those that are not in SCReWBase now? – 
Hopefully, you named all your records that do not have an entry in SCReWBase as a "900" 
record.  If this was done, then you will be able to send in all such records at once with a new 
functionality that will be provided at a later date. 
 


